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Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in 
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for 
use with this EPSON scanner. EPSON is not responsible for any use of this information as applied to other 
scanners.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third 
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, 
or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the 
U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any 
options or any consumable products other than those designated as Original EPSON Products or EPSON 
Approved Products by SEIKO EPSON CORPORATION.

A Note Concerning Responsible Use of Copyrighted Materials
Ink jet printers, digital cameras and scanners, like photocopiers and conventional cameras, can be misused by 
improper copying and printing of copyrighted material. While some countries’ laws permit limited copying of 
copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. 
EPSON encourages each user to be responsible and respectful of the copyright laws when using digital cameras and 
scanners.

Trademarks
EPSON is a registered trademark, and Matrix CCD is a trademark of SEIKO EPSON CORPORATION.
Micro Step Drive is a trademark, ColorTrue is a registered trademark, and EPSON Store and SoundAdvice are 
service marks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. EPSON disclaims any and all rights in those marks. 

Copyright © 2003 by Epson America, Inc.  CPD-17264
10/03

 Printed on recycled paper
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Welcome

The EPSON® GT-15000 is a 48-bit color, large-format professional scanner 
that delivers superior results and versatility for business users. Using EPSON’s 
ColorTrue® II Imaging System, the scanner captures text and images with 
amazingly accurate detail and color. Its 600 × 1200 dpi hardware resolution and 
11.7 × 17-inch scan bed let you quickly capture incredibly sharp images from 
practically any size source document.

About Your Scanner

Your EPSON GT-15000 scanner includes many advanced features.

■ 48-bit color depth and 600 × 1200 optical resolution let you capture crisp, clean 
text and high-quality images with millions of colors and thousands of shades of 
gray.

■ Speeds through documents with accuracy and detail: letter-sized monochrome up 
to 16 ppm, color up to 10 ppm (landscape at 300 dpi, draft mode).

■ Large scan bed and optional automatic document feeder let you quickly scan 
anything from a two-page book spread to a double-sided, 100-page document.

■ Built-in USB and SCSI interfaces, optional Network Image Express card or 
IEEE 1394 FireWire® interface card provide versatile connections for individual 
or workgroup users.

■ Convenient a Start button on the scanner lets you place your document and start 
your scan immediately. If the scanner is set up for network use, you can 
automatically send the image back to your workstation.

■ EPSON Scan software provides automatic paper size detection. Includes 
additional software for document management, optical character recognition, and 
image editing.
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About Your Software

The EPSON GT-15000 comes with these applications:

■ EPSON Scan
General-purpose driver for scanning photographs, artwork, documents, or text for 
Optical Character Recognition (OCR). Includes automatic document size 
recognition and three modes for progressive levels of control over your scanned 
image.

■ ABBYY FineReader® 5.0 Sprint 
A powerful, easy-to-use OCR program that lets you scan and send the text to a 
word processor or spreadsheet program. You can save scanned documents in RTF, 
TXT, or PDF format.

■ ScanSoft® PaperPort® Deluxe 
Use this leading document management software to scan your paper documents 
and then organize, file, edit, copy, fax, and e-mail them from one convenient 
screen.

■ Adobe® Photoshop® Elements 
State-of-the-art software lets you create high-quality images for print, e-mail, and 
the Web. Includes sophisticated, yet easy-to-use tools for correcting and 
enhancing digital images.

Getting More Information

There are several ways to learn more about your EPSON GT-15000 scanner. In 
addition to this User’s Guide, help utilities and electronic manuals are available. Here’s 
where to look for help:

■ EPSON GT-15000 Reference Guide
Provides instructions on using EPSON Scan, scanning in a network environment, 
and additional information about your scanner. You can view the Reference Guide 
from the CD-ROM or copy it to your computer and view it from there. See 
page 9 for instructions on viewing the electronic manual.
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■ On-Screen Help
For more information about any of the software that came with your scanner, 
click the Help button or access the Help menu. 

■ Electronic Documents
FineReader Sprint, PaperPort Deluxe, and Photoshop Elements all include 
electronic manuals in Adobe Acrobat® PDF format.

If none of these sources answers your questions, please see “Where To Get Help” on 
page 61.

Warnings, Cautions, Notes, and Tips

Please follow these guidelines as you read this manual:

Warning: Must be followed carefully to avoid bodily injury.

Caution: Must be observed to avoid damage to your equipment.

Note: Contains important information about your scanner.

Tip: Contains additional hints for great scanning.

Viewing Your Electronic Reference Guide

Your scanner software CD-ROM includes an on-screen Reference Guide. You must 
have a web browser (Netscape Navigator® or Microsoft® Internet Explorer, versions 
4.0 or later) to view it. 

You can view the guide from the CD-ROM or copy it to your computer and view it 
from there.

1. Insert the scanner software CD-ROM in the CD-ROM or DVD drive. The 
installer starts automatically. If it doesn’t start, do one of the following:

■ Windows® XP: Click Start, click My Computer, then double-click EPSON.

■ Windows 98, Me, and 2000: Double-click My Computer, then double-click 
EPSON.

You see the EPSON Installation Program.
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2. Double-click User Guides on the 
Installation Program window. You see 
this screen:

3. Click Install Reference Guide, then 
follow the on-screen instructions. When 
installation is complete, click Quit.

If you install the guide on your computer, 
you can access it at any time by clicking 
Start > All Programs or Programs > 
EPSON > GT-15000 Guide.

Your browser opens and you see this window:

Click a topic on the left side of the screen to expand the table of contents. After 
expanding the table of contents, you can click on the topic you want to view.
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Chapter 1

Getting Started

This chapter describes the following procedures:

■ Unpacking the scanner

■ Installing the software

■ Connecting the scanner to your computer

■ Turning on the scanner

Unpacking the Scanner

Remove the scanner from the box and make sure you have all the parts:

Remove all the tape and packing material from the scanner. Save the packaging in case 
you need it for transporting the scanner.

Warning: The scanner is large and heavy. You might need to have someone help 
you unpack and lift it.

Scanner
Power cord

USB cable

CD-ROM with EPSON 
Scan driver, software, 
and electronic manuals

Adobe Photoshop 
Elements 2.0 CD-ROM

GT15K.book  Page 11  Wednesday, November 12, 2003  8:48 AM



12 Getting Started

Choosing a Good Place for the Scanner

When deciding where to place the scanner, follow these guidelines:

■ Place the scanner on a flat, stable surface. If the scanner is tilted, it can’t operate 
properly.

■ Make sure to place the scanner where you can easily unplug the power cord, near 
a grounded wall outlet, and where your cable can reach your computer. 

■ Keep the scanner away from direct sunlight and strong light sources.

■ Avoid places subject to shocks and vibrations, or high or rapidly changing 
temperatures and humidity.

■ Make sure there’s enough room behind the scanner for the cables, and above the 
scanner so you can fully raise the document cover. 

23 inches 
(573 mm)

6 inches 
(150 mm) or more

18 inches 
(458 mm) 26 inches 

(656 mm)

5 inches 
(132) mm

GT15K.book  Page 12  Wednesday, November 12, 2003  8:48 AM



Getting Started 13

Installing the Software

You must install the software before connecting the scanner to your computer. The 
installation process may take several minutes. Be sure to close all open programs and 
turn off any virus protection programs.

Caution: Make sure the scanner is not connected to your computer before you 
install the software.

If you want to use Adobe Photoshop Elements, install it from the CD-ROM included 
with your scanner. 

Then follow these steps to install the EPSON Scanner Software CD-ROM:

1. Insert the scanner software CD-ROM in the CD-ROM or DVD drive. The 
installer starts automatically. If it doesn’t start, do one of the following:

■ Windows XP: Click Start, click My Computer, then double-click EPSON.

■ Windows 98, Me, and 2000: Double-click My Computer, then double-click 
EPSON.

You see the EPSON Installation 
Program:

2. Double-click Install Software. 
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You see the EPSON Software 
Installation screen:

3. Click Install.

4. Read the license agreement, then 
click Accept.

Wait while the software is installed.

If you see a message prompting you 
to restart, click Restart Windows. 
After your computer restarts, go back 
to step 1 on page 13 and continue 
installing software.

If you see a message prompting you 
to close EPSON Software Installation before continuing to install PaperPort, 
click Ignore.

5. When you see the message that installation is complete, click OK.

6. Double-click User Guides on the 
Installation Program window. You see this 
screen:

7. Click Install Reference Guide, then 
follow the on-screen instructions. When 
installation is complete, click OK, then 
click Quit to close the window.

8. Double-click Register Your Scanner 
and follow the instructions on the screen 
to complete the registration. At the last 
screen, click Done or close your browser.

9. Click  to close the Installation Program, then remove the CD-ROM. 

After you have installed the software, follow the instructions in one of the next 
sections to connect the scanner to your computer.

You can connect the scanner using either the USB cable that came with your scanner, 
or a SCSI cable. Don’t connect more than one cable.
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Note: You can also install optional interface cards in the scanner and use these 
for connecting to your computer system. For information about installing and 
using the optional IEEE 1394 (FireWire) card or EPSON Network Image Express 
card, see Chapter 3, “Using Optional Equipment.”

Connecting the Scanner Using the USB 
Interface

Before you connect the scanner, make sure you have installed the software, as 
described on page 13. 

Plug the flat end of the USB cable into any available USB port on your computer or 
powered USB hub. Plug the square end into the scanner’s USB port.

Note: Your scanner may not work correctly if you use a USB cable other than the 
one supplied by EPSON, or if you connect your scanner to a multi-level USB hub 
system.
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Connecting the Scanner Using the SCSI 
Interface

Before you connect the scanner, make sure you have installed the software, as 
described on page 13. Then turn off your computer.

In order to use the SCSI connection, you need to make sure your computer has a 
SCSI board and any necessary SCSI software installed. Then follow these steps to 
connect the scanner:

1. If you have another SCSI device that 
uses SCSI ID 2, turn the SCSI ID 
switch on the back of the scanner to a 
new number. Do not use 0, 1, or 7.

2. Unless your scanner is connected in 
the middle of a SCSI chain, leave the 
terminator switch on the back of the 
scanner turned On.

3. Squeeze the lock releases on your 
SCSI cable, and plug it into either 
SCSI connector on the back of the 
scanner. Connect the other end of 
the cable to the SCSI port on your 
computer.
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Turning On the Scanner

1. Pull up the transportation lock to the Unlock 
position.

2. Before you plug in the scanner, make sure it is 
turned off (the . Power button is not pushed 
in). 

3. Plug one end of the scanner’s power cord into 
the AC inlet at the back of the scanner, and the 
other end into a grounded electrical outlet.

4. Press the . Power button on the front 
of the scanner to turn it on. 

The green Ready light starts flashing.

5. If your computer is off, turn it on. 

6. Wait until the Ready light stops 
flashing, then do one of the following:

■ USB: If you see a message that the 
software has not passed Windows 
Logo testing or does not contain a 
Microsoft digital signature, click 
Yes or Continue Anyway.

■ SCSI: Start the Add Hardware Wizard in the Windows Control Panel. Follow 
the on-screen instructions to let Windows detect the scanner.

Note: If you see a message about a HIGH-SPEED USB device, click the x in the 
corner of the message to close it. Your scanner will work correctly, although not 
at maximum speed.

Transportation lock

Ready light

. Power button
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Chapter 2

How To Scan

The EPSON Scan software included with your EPSON GT-15000 provides three 
modes to give you progressive levels of control over the scanning process: 

■ Home Mode: Makes scanning quick and easy. It includes a simple interface, 
automatic image adjustments, and preset configurations for various types of scans.

■ Office Mode: Includes a basic interface with practical scan settings designed for 
documents. Choose this mode to scan multi-page documents on the optional 
automatic document feeder (see page 38). 

■ Professional Mode: Lets you manually configure advanced image settings, 
including the histogram setting, tone, color depth, balance, saturation, brightness, 
and contrast.

You can use EPSON Scan either in a “standalone” mode, or by starting from another 
program, such as PaperPort Deluxe or Photoshop Elements.

This chapter provides step-by-step instructions for the following:

■ Placing your original document on the scanner

■ Scanning documents with PaperPort Deluxe

■ Scanning text for editing (OCR)

■ Scanning photographs with Adobe Photoshop Elements

■ Scanning to a file with EPSON Scan

■ Scanning with the a Start button.

■ Advanced scanning 

■ Selecting the scanning area 

■ Scanning tips
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Placing Your Original Document

This section explains how to position documents or photos for scanning. 

If you’re scanning a multi-page document using the optional automatic document 
feeder, see “Scanning With the Automatic Document Feeder” on page 41.

1. Raise the scanner cover and place your document face down in the upper left 
corner of the document table.

You can scan several pages or photos at the same time. Make sure you leave about 
an inch of space between them on the document table.

2. Close the document cover slowly. Be careful not to move the document.

Tip: If the edges of your document don’t scan properly, move it in one-quarter 
inch from the edges of the document table.

You can remove the document cover if you need to scan a thick item—such as a 
book—that doesn’t fit under the cover. Simply lift the back of the cover straight 
up. When you reattach the cover, line the rods up with the positioning holes and 
lower the cover into place.

Warning: Before removing the document cover, make sure you raise it all the 
way up. This will prevent the hinges from snapping back on the springs and 
possibly injuring you.
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Scanning Documents with PaperPort 
Deluxe

The PaperPort Deluxe software included with your scanner lets you scan and manage 
a variety of documents. You can use PaperPort to file and organize documents on 
your computer just as you would handle paper documents, with the added 
convenience of searching by content as well as title. 

First, place your document or documents on the scanner as described on page 20. 
Then follow these steps to scan with PaperPort Deluxe:

1. To start PaperPort, click Start > Programs or All Programs > ScanSoft 
PaperPort > PaperPort. You see the PaperPort desktop, with several sample 
documents and images:

2. Click the Scan button. 

Scan 
button
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You see these settings on the left side of the screen:

3. Select EPSON GT-15000 and Document, as shown. 
Make sure you don’t select WIA-EPSON GT-15000. 
Then click the Scan button. EPSON Scan opens. 

4. Choose the Office Mode from the Mode list at the top 
of the EPSON Scan window. If you see a warning message 
about closing the preview window, click OK. 

You see the EPSON Scan Office 
Mode settings:

5. Choose an Image Type:

■ Color for documents with color

■ Grayscale for documents with 
grayscale images or black and 
white photos

■ Black&White for plain text 
documents

6. Click Preview if you want to see a 
preview of your scan. 

7. Click the  Auto Detect button in 
the preview window to 
automatically select your entire 
document, or click and drag in the 
preview window to create a scanning 
selection area (marquee). For more 
information on using marquees, see 
page 34.

Scan button
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8. Make any of these adjustments, as necessary:

■ Select a resolution

■ Adjust the Brightness and Contrast settings for your image

■ If you’re scanning printed materials, select Descreening Filter to reduce the 
moiré patterns in the image

■ To sharpen the image, select Unsharp Mask Filter

9. Click the Scan button. 

Your document is scanned, then displayed on the PaperPort desktop. You can file 
it, send it to an application, email it, or work with it in PaperPort. 

For more information, see the PaperPort Help or User’s Guide (on the PaperPort 
Help menu).

Scanning Text for Editing

The ABBYY FineReader Sprint software included with your scanner lets you turn 
almost any printed document into editable text. First, place your document or 
documents on the scanner as described on page 20. Then follow these steps to scan 
text for editing:

1. To start ABBYY Fine Reader, click Start > Programs or All 
Programs > ABBYY FineReader Sprint. You see the program 
window with menus and buttons at the top.

2. Click the Scan&Read button. EPSON Scan opens.

3. Choose the Office Mode from the Mode list at the top of the 
EPSON Scan window. 
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You see the EPSON Scan Office 
Mode settings:

4. For most text scanning, choose 
Black&White and use the default 
settings, as shown.

5. Click the Scan button. Your 
document is scanned and opens in 
the ABBYY FineReader window.

6. Click the Save button. You see a 
standard Windows file save window. 
Choose a location, file name, and 
one of the following file types:

■ rtf: for editing in Microsoft 
Word.®

■ pdf: for a “portable document 
file” that you can use in Adobe 
Acrobat.

■ txt: for an unformatted text file 
that you can open in many 
different programs.

You can also click the down arrow next to the Save button and choose to send 
the text to Microsoft Word or Excel,® or Adobe Acrobat. For more information 
about ABBYY FineReader, open the Help menu at the top of the screen.

Scan button

GT15K.book  Page 24  Wednesday, November 12, 2003  8:48 AM



How To Scan 25

Scanning Photographs With Adobe 
Photoshop Elements

Adobe Photoshop Elements provides a variety of powerful tools for image editing, 
along with recipes and step-by-step instructions for using the tools. First, place your 
photo or photos on the scanner as described on page 20. Then follow these steps to 
scan photos with Photoshop Elements:

1. Double-click the Adobe Photoshop Elements 2.0 icon on your desktop. You see 
the Photoshop Elements window, with the welcome screen on top:

2. Click Connect to Camera or Scanner. You this 
window:

3. Select EPSON GT-15000 and click OK. EPSON Scan 
opens.

Note: You can also open the File menu and choose Import > GT-15000. When 
selecting the source, make sure you don’t choose WIA Support.
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4. Choose the Home mode from the Mode list at the top of the 
EPSON Scan window. (If you want to use the Professional 
Mode, see page 31.) 

You see the Home mode EPSON Scan settings:

5. If you don’t see an automatic preview of your scan, click Preview. 

6. Click the  Auto Detect button in the preview window to automatically select 
your entire photo, or click and drag to create a scanning selection area (marquee). 
For more information on using marquees, see page 34.

Note: If the scanned image in the preview window has a blue box around it, 
you’re previewing in thumbnail mode. This allows you to scan multiple photos 
and automatically select them. If you want to select part of an image, click the 
arrow beside the Preview button in the EPSON Scan dialog box and select 
Normal from the pull-down menu. Then click the Preview button to preview in 
normal mode. 
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7. Choose Photo in the Document Type list.

8. Choose an Image Type:

■ Color for color photos

■ Grayscale for black-and-white photos 

9. Choose a Destination setting:

■ Printer if you’re printing the image

■ Screen/Web if you will only view your image on the screen

■ Other if you want to specify a resolution

10. Select a Target Size if you want to specify any size other than that of the original 
document.

11. Adjust the Brightness and Contrast settings, if necessary.

12. Click Scan. If you are scanning multiple photos, each one is scanned 
individually. 

13. Click Close to exit EPSON Scan and work with your image(s) in Photoshop 
Elements.

For more information about using Photoshop Elements, click the Help menu at the 
top of the screen.
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Scanning to a File With EPSON Scan

You can use the import or acquire function of a TWAIN-compliant application such 
as PaperPort Deluxe or Adobe Photoshop to scan images directly into your 
application. Or you can scan directly to your computer by starting EPSON Scan from 
the Windows Start menu. 

First, place your document or photo on the scanner as described on page 20. Then 
follow these steps:

1. Click Start > Programs or All Programs > EPSON Scan > EPSON Scan. 

Note: If you have multiple scanners installed, you are prompted to choose your 
scanner. Click EPSON GT-15000 and click OK.

2. Choose a mode from the Mode list at the top of the EPSON 
Scan window. See page 19 for descriptions of the three 
modes. 

If you choose Home Mode, a preview scan opens 
automatically. (This is the default. If you don’t want an automatic preview, 
deselect Auto Preview on the EPSON Scan dialog box.)

3. Continue with the instructions for your mode:

■ Office mode on page 22

■ Home mode on page 26

■ Professional mode on page 31

4. Click Scan. You see a File Save Settings 
window:

5. Type a name for your file in the Prefix field, 
then choose an image type and click OK. (For 
more details, see the EPSON Scan on-screen 
Help.)
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Scanning With the Start Button

You can use the a Start button on your scanner to open EPSON Scan, and then scan 
your document as described on page 28. Or, you can set up the a Start button to 
open any compatible program on your computer and start scanning.

If you have set up the scanner on a network, you can use the a Start button to scan 
automatically and send the document to an individual computer. For instructions on 
network scanning, see your on-screen Reference Guide.

First, place your document or photo on the scanner as described on page 20. Then 
follow these steps to use the a Start button:

1. Press the a Start button. 

If you’re using Windows 98, Me, 
or 2000, EPSON Scan opens. If 
you want to have a different 
application open, see the 
instructions on page 30.

If you’re using Windows XP, you 
see this window:

2. Select the program you want to use. 

To have the program open automatically 
whenever you press the a Start button, check 
Always use this program for this action.

3. Click OK. 

If you want to change the program after you 
set up the a Start button, open the Scanners 
and Cameras utility in the Windows Control 
Panel.

Right-click your scanner and select Properties. Select the Events tab, then select 
the program you want to use.

a Start button
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Setting Up the Start Button in Windows 98, Me, 
or 2000

EPSON Scan opens by default when you press the a Start button. If you want to 
have a scanning application open instead, follow these steps:

1. Click Start > Settings > Control Panel.

2. Double-click the Scanners and Cameras icon. 

3. Do one of the following:

If you’re using Windows 98 or 2000, 
select your scanner from the list of 
devices and click Properties.

If you’re using Windows Me, right-click 
the scanner icon and select Properties.

4. Select the Events tab. You see a 
window like the one on the right:

5. Make sure Start Button is selected 
under Scanner Events.

6. Select the application you want to open 
with the a Start button. Make sure you 
clear the checkboxes for all the other 
applications.

If you want to choose from a list when you press the a Start button, you can 
select multiple applications.

7. Click Apply, then click OK.
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Advanced Scanning in Professional Mode

First, place your photo or document on the scanner as described on page 20. Then 
follow these steps:

1. Start EPSON Scan and choose Professional Mode from the Mode menu. You 
see this window:

2. Click Preview to see a preview of your scan. 

3. Click the  Auto Detect button in the preview window to automatically select 
your entire document, or click and drag in the preview window to create a 
scanning selection area (marquee). For more information on using marquees, see 
page 34.

4. Choose the Auto Exposure Type: Photo to optimize exposure for photos, or 
Document to optimize exposure for printed material. 

Select Professional 
Mode
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5. Either click Scan to complete your scan, or continue with the instructions in the 
next section to fine-tune it.

Using Professional Mode To Customize Your Scan

Follow these steps to use advanced settings:

1. Choose a color depth setting from the Image Type menu: 

■ 24-bit Color for the highest quality color scans

■ Color Smoothing for color documents without photographs

■ 8-bit Grayscale for the highest quality scans of black-and-white photos or 
images

■ Halftone if you want to select special halftone patterns

■ Black & White for text or line art 

Click  to see more options, then choose Best or Draft for the Scanning Quality 
setting.

2. Choose a resolution setting (50 to 9600 dpi).

3. If you want to specify a Target Size for 
your scanned image other than the 
original size, select a size from the 
pull-down menu. You can also click  to 
see more options, then type in the width 
and height, or scale the image with a 
percentage. If Trimming is set to On, your image is cropped to fit your specified 
size. If it is Off, your image is sized to fit your specified size as closely as possible.

4. Use the Adjustment settings to modify your image as necessary. (You may have to 
use the scroll bar to see these options.)

Auto Adjust – Click this button to let the software detect and analyze the 
image with the document settings you’ve specified to determine the optimum 
settings for your scan. 

Histogram Adjustment – Click this button to adjust the highlight, shadow, 
and gamma input levels. 
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Tone Correction – Click this button to choose a preset tone curve for specific 
effects or to change the tone curve manually. 

Image Adjustment – Click this button to adjust the color balance, saturation, 
brightness, and contrast settings. 

For any of the setting windows above, you can click Reset to go back to the 
default settings for your image. See the EPSON Scan on-screen help for more 
information about the Adjustment options. 

5. If you want to sharpen the image, select 
the Unsharp Mask Filter option. Click  
to see more options, then choose a Level to 
reduce or increase the effect. 

6. Select the Descreening Filter option to reduce the moiré patterns in the image. 

To specify the source image you are scanning, click  to see more options, then 
choose the closest option to your source document in the Screen Ruling menu. 
(You may have to use the scroll bar to see this menu.) 

7. Click Scan. 
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Selecting the Scanning Area in the Preview 
Window

The preview window lets you select the area of your image that you want to scan with 
a marquee (a frame that you draw around the previewed image). You can create up to 
50 marquees at one time. The currently selected marquee has a moving, dotted line. 
EPSON Scan adjusts the image quality settings to optimize each selected area.

■ To automatically create a marquee around the entire image (and cut out the 
document table area) click the  Auto Detect button. 

■ To select the area to scan, click and drag in the preview window. A marquee 
appears around the selection.

■ To move the marquee, move the cursor to its center. When the cursor turns into a 
hand symbol, click and drag the marquee to a new position. 

Auto Detect 
button

Currently 
selected 
marquee
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■ To resize the marquee, move the cursor to an edge or corner of the dotted line. 
When the cursor turns into an arrow symbol, click and drag to resize the 
selection area. 

■ To zoom to the selected area, click the  Zoom button. If you have multiple 
marquees, the currently selected one appears in the Zoom preview. 

■ To erase a marquee, click the marquee and click the  Delete button. 

■ To create multiple marquees of the same dimensions, select one marquee, then 
click the Duplicate button. 

■ To scan all selected areas at once, click the All button. 

Scanning Tips

Getting the best scan possible depends on several factors, including the quality of your 
original and the resolution you select. The better your original is, the better your scan 
will be. To get the best possible scan, keep the document table clean, and make sure 
the document is flat against the glass surface. You can make many corrections in your 
scanning software. For additional photo retouching, use an image editing program 
such as Adobe Photoshop Elements.

Selecting Resolution

Resolution refers to how many dots per inch (dpi) or dots per centimeter (dpcm) your 
image contains. The best resolution for a scanned image depends on the type of image 
you’re scanning and your final output device. 

For most images, use a scanning resolution that is approximately one third of your 
output resolution. For example, use a scanning resolution of 200 dpi if you want to 
print at 600 dpi. If you’re scanning an image to view on-screen, choose a resolution 
of 96 dpi. 
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Follow the guidelines in this table for selecting a resolution:

Scaling (Resizing) Images 

If you plan to enlarge your image, it’s better to enlarge it by scanning at a higher 
resolution. If you change the image resolution or size in an application, you lose image 
quality. Keep this in mind when scanning small photos that you plan to enlarge. 

Scanning Color Images 

If the colors in your scanned image don’t match those in your original document, try 
experimenting with the Document Type/Image Type settings and Image Adjustment 
settings to adjust the colors. Also, try selecting just the area that you want to scan with 
a marquee (see page 34). This will let the scanner software choose the optimum color 
and exposure settings for that part of the image. If there is a border around your image 
or if the document cover is in the scanning area, this may adjust the exposure and 
colors in your scan. 

Type of scan Resolution 

Photograph 300 dpi

Text with images 400 dpi

Line art 300 to 1200 dpi

Image for web 96 to 150 dpi

Text for OCR 400 dpi

Newspaper 400 dpi

Magazine 300 dpi
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Chapter 3

Using Optional Equipment

Three options are available for the EPSON GT-15000 color scanner: 

■ Automatic document feeder (B813212) 

■ EPSON IEEE 1394 FireWire scanner interface card (B808342)

■ EPSON Network Image Express scanner interface card (B808392) 

You can purchase these accessories from the EPSON StoreSM at (800) 873-7766, or 
visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for 
dealer referral.

Follow the instructions in this chapter for:

■ Unpacking and installing the automatic document feeder

■ Scanning with the automatic document feeder

■ Fixing jams in the automatic document feeder

■ Installing the IEEE 1394 FireWire scanner interface card

■ Installing the Network Image Express card
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Automatic Document Feeder

The automatic document feeder (B813212) allows you to load and scan multiple-
page documents. You can scan up to 100 sheets at a time, either one-sided or 
two-sided. 

When you unpack your automatic document feeder, make sure you have the parts 
shown below. If any items are missing or damaged, contact your EPSON dealer, or 
call EPSON at (562) 276-4382 (in the United States) or (905) 709-3839 (in 
Canada).

Warning: The automatic document feeder is large and heavy. You might need to 
have someone help you unpack it and set it up.

Screws

Automatic 
document feeder

Knobs
Screwdriver

Feet
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Installing the Automatic Document Feeder

1. Make sure your scanner is turned off and 
the power cord is unplugged. 

2. Open the document cover, then grasp the 
back of the cover and lift it off the scanner.

Warning: Before removing the document 
cover, make sure you raise it all the way up. 
This will prevent the hinges from snapping 
back on the springs and possibly injuring you.

3. Make sure the document table is clean and 
dust free.

4. Attach the two smaller feet to 
the automatic document 
feeder, as shown on the right: 
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5. Insert the two installation screws into the holes on the back of the scanner, then 
tighten the screws with the screwdriver.

6. Align the screws with the holes in the automatic document feeder. Then slide the 
holes over the installation screws. Make sure the small pegs below the holes on the 
feeder go all the way into the back of the scanner.

Warning: Make sure you have someone help you lift the automatic document 
feeder.

7. Secure the knobs to the ends of the 
installation screws using the included 
screwdriver. 

Make sure the base of the feeder is flush 
against the back of the scanner.
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8. Attach the cable to the scanner’s ADF 
connector and tighten the screws.

9. Make sure the switch on the 
underside of the feeder is set towards 
the circle, as shown. Then lower the 
automatic document feeder.

Once the automatic document feeder is 
attached, you can plug in the scanner’s 
power cord and connect the cable. 

If you’re using the SCSI connection, 
you need to restart your computer after 
plugging in the feeder.

Then follow the steps in the next sections to scan with the automatic document 
feeder.

Scanning With the Automatic Document Feeder

Your automatic document feeder can load up to 100 pages at a time. You can load 
letter-size or smaller pages in either landscape or portrait orientation. You can load 
larger pages in the portrait orientation only.

Follow these guidelines when scanning with the automatic document feeder:

■ Make sure the ink on the document is dry.

■ Make sure the document has no holes, cut-outs, wrinkles, tears, carbon coating, 
staples, or other attachments.

■ Make sure the document is not folded near the edges and is not a multi-part form.

■ Do not place photos or valuable original artwork in the feeder. These should be 
scanned individually.
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Follow these steps to scan:

1. Slide the edge guide all the way out.

2. Insert your document face up in the 
feeder, bottom edge first, until it 
meets resistance. 

Note: Don’t push the document into 
the feed path or the pages may jam.

3. Move the edge guide so it touches the 
edge of your paper.

4. Scan your document. Follow these 
guidelines to use EPSON Scan:

■ Select the Office Mode in the 
Mode box.

■ Select ADF-Single-sided or 
ADF-Double-sided as the 
Document Source. 

■ If you want to scan only part of 
the document page, load the 
first page only. 

Click the Preview button. 
The first page is ejected. Adjust 
the marquee in the Preview 
area, then load your entire 
document. When you click 
Scan, the scanner scans the 
area defined by the marquee 
on each page.

Note: You can still load documents 
manually, if you want. Just lift the 
automatic document feeder and 
place your document face down on 
the document table. Select Document Table as the Document Source in EPSON 
Scan. Be sure to close the automatic document feeder before scanning. If you 
open it while scanning, you’ll get an error.
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Fixing Document Jams

If a document gets jammed in the feeder, follow these steps to clear it:

1. Lift up the feeder and determine where the jam occurred.

2. If the jam is on the left, open the left cover. If the jam is on the right, open the 
right cover. Slowly pull the jammed pages out of the feeder mechanism. Be careful 
not to tear the paper.

If a page tears, open the middle cover 
and remove it as shown:

3. After removing the jammed pages, close 
the covers and lower the feeder. Make 
sure the red Error light is off and the 
green Ready light isn’t flashing before 
trying to scan.

4. If the error isn’t cleared, turn your 
scanner off and then on again. Also, 
close EPSON Scan. Don’t restart 
EPSON Scan until the green Ready 
light stops flashing.

Note: If you attempt to preview or scan before the scanner is ready, EPSON Scan 
may stop responding. If this happens, restart your computer. 

Left jam Right jam
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Installing the IEEE 1394 FireWire Scanner 
Interface Card

The IEEE 1394 FireWire scanner interface card 
(B808342) offers high-speed image transfer and 
flexible connectivity for your scanner. It supports a 
peak data transfer rate of 400 Mbps, and allows you 
to connect multiple IEEE 1394 devices. The card 
and included cable are shown on the right:

To use the IEEE 1394 FireWire interface card, your 
system must have the following:

■ Built-in IEEE 1394 FireWire port or IEEE 
1394 FireWire PCI card (OHCI-compliant)

■ Pre-installed version of Windows XP, 2000 Professional, or Me 

Follow the steps below to install the IEEE 1394 FireWire card in your scanner and 
connect it to your computer.

1. Turn off the scanner and disconnect the power cord and any cables.

Caution: Static electricity can damage electronic components like the IEEE 1394 
FireWire scanner interface card. To discharge static electricity, touch the 
scanner’s metal frame before handling the card.

2. Remove the two screws securing the shield 
plate to the scanner’s optional interface slot. 
Then remove the plate. 

Put the screws and shield plate in a safe place 
in case you want to reinstall the shield plate 
later.
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3. Turn the card over so that the 
component side is facing down, and 
insert it in the optional interface slot. 

4. Push gently until the card is firmly 
seated.

5. Tighten the retaining screws and 
reconnect the scanner’s cables.

6. Plug one end of the IEEE 1394 cable 
into the IEEE 1394 port on the card, 
and the other end into an IEEE 1394 
(FireWire) port on your computer.
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Installing the Network Image Express Card 

The Network Image Express card (B808392) allows you to share your scanner 
without the need for a server. The card supports 10BaseT/100BaseT full and half 
duplex networks. 

Any computer on the network that has the 
EPSON Scan software installed can scan and 
import a document from the EPSON 
GT-15000.

For information on setting up and using the 
scanner on a network, see your on-screen 
EPSON GT-15000 Reference Guide.

Follow these steps to install the card in your scanner and connect it to your network:

1. First, turn off the scanner and disconnect the power cord and any cables.

Caution: Static electricity can damage electronic components like the Network 
Image Express Card. To discharge static electricity, touch the scanner’s metal 
frame before handling the card.

2. Use a cross-head screwdriver to remove the 
two screws securing the shield plate to the 
optional interface slot. Then remove the 
plate. 

Put the screws and shield plate in a safe 
place in case you want to reinstall the 
shield plate later.

3. Turn the card over so that the 
component side is facing down, and 
insert it in the optional interface slot. 

4. Push gently until the card is firmly 
seated.

5. Tighten the retaining screws and plug in 
the scanner.
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6. To initialize the card, turn on the scanner while holding down the reset button on 
the card for about 10 seconds. The red and green lights on the card turn on.

7. Wait until the red and green lights turn off, then turn off the scanner.

8. Connect an Ethernet cable to the 
connector on the card. Make sure 
you use a Category 5 shielded 
twisted-pair cable.

9. Connect the other end of the cable 
to your network hub.

For information on configuring the scanner for your network, see the EPSON 
Network Image Express Card User’s Guide that came with the card.

Reset button

Lights
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Chapter 4

Maintenance

To protect your scanner and ensure optimum performance, follow the instructions in these 
sections:

■ Transporting the scanner

■ Cleaning the scanner

Transporting the Scanner

Always secure the carriage when you transport the scanner a long distance or store it for an 
extended time.

1. If you’re using the automatic document feeder, remove it from the scanner and replace the 
scanner cover. 

Warning: Make sure you have someone help you lift the automatic document feeder. 

2. Turn on the scanner and wait until the carriage moves left to the home position. Then turn 
off the scanner.

3. Push down the transportation lock at the 
back of the scanner to the Lock position.

4. Use the scanner’s original box, or a similar 
box with enough packaging material to 
prevent movement inside the box.

5. Pack the automatic document feeder in its 
original box, or use a similar box with 
enough packaging material to prevent any 
movement inside the box.

Transportation lock
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Cleaning the Scanner

To keep your scanner operating at its best, clean it periodically. 

1. Press the . Power button to turn the scanner off, and unplug the power cord.

2. Use a soft, damp cloth and mild detergent to clean the outer case.

Caution: Don’t let water get into the scanner.

3. Clean dust and smudges from the document table glass with a soft, dry cloth (a 
microfiber glass cleaning cloth is recommended). You can also use compressed air 
dust remover sprays. Dust on the glass can cause white spots to appear in your 
scanned image. 

To remove grease, use pretreated lens/scanner wipes, or a small amount of glass 
cleaner on a soft cloth. Dry the document table glass afterwards.

Cautions: Always unplug the scanner before cleaning.

Never use a harsh or abrasive brush or cleaning product to clean the document 
table. A damaged glass surface can decrease the scanning quality.

Never use alcohol, thinner, or corrosive solvent to clean the scanner. These 
chemicals can damage the scanner components as well as the case.

Be careful not to spill liquid into the scanner mechanism or electronic 
components. This could permanently damage them.

Don’t spray lubricants inside the scanner.

Never open the scanner case. If you think repairs or adjustments are necessary, 
consult your dealer or contact EPSON.

Unplug the scanner and refer servicing to qualified service personnel if the power 
cord or plug is damaged, if liquid has entered the scanner, if the scanner has been 
dropped or the case damaged, or if the scanner does not operate normally or 
exhibits a distinct change in performance.
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Chapter 5

Solving Problems

This chapter explains how to interpret the signals from your scanner’s lights, and gives 
you the basics for diagnosing and solving scanner problems. It also tells you how to 
uninstall your software and how to contact EPSON.

See “Diagnosing Scanner Problems” in the next section to determine what the cause 
of your scanner problem might be. Then see these sections for solutions:

■ Scanner Problems

■ Software Problems

■ Quality Problems

■ Uninstalling and Reinstalling EPSON Scan

■ Where To Get Help

Tip: It’s a good idea to check EPSON’s support web site periodically for possible 
updates to your scanner software. Visit http://support.epson.com and check to 
see if there is new software available, free of charge, for downloading to your 
computer. Download instructions are posted for your convenience.
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Diagnosing Scanner Problems

You can diagnose some problems by checking the scanner’s lights, as described in this 
section. If you don’t find the answer here, see “Problems and Solutions” on page 53.

 

Light Scanner Status

Ready light is on or 
flashing.

The green Ready light is on when the scanner is ready to scan. 
It flashes when scanning is in progress.

Error light is flashing; 
Ready light is off.

There’s a problem with your cable connection. Reconnect the 
cable to both the scanner and your computer, and then restart 
your computer. If this doesn’t work, try using a different cable. 
If you have a USB connection, use the USB cable that came 
with your scanner. If you have a SCSI connection, always 
restart your computer after changing or reconnecting the 
cable.

Error and Ready 
lights are both on.

The scanner has received an incorrect command from your 
scanning software. Try scanning again.

Error and Ready 
lights are both off.

Make sure your scanner is connected to a working outlet, then 
press the . Power button. Restart your computer.

If the green Ready light doesn’t come on, there may be a 
problem with the automatic document feeder, or the cover 
may be open. Make sure the cover or automatic document 
feeder is closed. If you are using the feeder, make sure a 
document is loaded, and pages are not jammed.

Error and Ready 
lights are both 
flashing.

Check that the transportation lock on the back of the scanner is 
set to Unlock. If not, unlock the scanner, then turn it off and 
back on again. Restart your computer. If this doesn’t solve the 
problem, contact EPSON as described on page 61.

Error light
Ready light

a Start button

. Power button
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Problems and Solutions

Here are some troubleshooting tips if you’re having trouble setting up your scanner, 
scanning, or getting the quality you want from your scans.

Scanner Problems

The Ready light doesn’t come on or 
flashes. 

■ The Ready light flashes when 
scanning is in progress. If you are 
scanning a large file, wait for 
scanning to finish.

■ Make sure the scanner power cord 
is securely plugged into the 
scanner and the power outlet, and 
that the scanner is turned on. If the 
scanner was unplugged or off, 
restart your computer before trying 
to scan. 

■ Check that the power outlet is 
working and provides sufficient 
power for the scanner.

■ If you’re using the automatic 
document feeder and both the 
Ready and Error lights are off, 
make sure the feeder is closed. 
Reconnect the feeder to the ADF 
connector on the back of the 
scanner. Then restart your 
computer.

■ If you’re using the automatic 
document feeder, make sure a 
document is loaded, and pages are 
not jammed. If a jam occurs, remove 
the jammed pages as described on 
page 43.

■ If you’re using the SCSI connection, 
make sure the SCSI ID is set 
between 2 and 6. If you reset the 
SCSI ID switch on the back of the 
scanner, turn the scanner off and 
then on again. Then restart your 
computer.

You see an error message when you 
try to scan.

■ Make sure your scanner is turned 
on. 

■ Check your cable connections. 

■ If you have a USB connection, use 
the cable that came with the 
scanner. Try using a different USB 
port. If your scanner is connected to 
a USB hub, connect it directly to the 
computer’s USB port. 
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■ Check the Device Manager in the 
Windows Control Panel System 
utility. If you see a ! or ? mark, or 
the scanner appears as an 
Unknown Device, remove the 
scanner. Uninstall and reinstall 
EPSON Scan as described on 
page 60.

■ If you have a SCSI connection, 
turn off both your scanner and 
computer. Then turn on your 
scanner before you turn on the 
computer.

■ If you have a SCSI connection, 
make sure your SCSI board is 
installed correctly. Check the 
Device Manager in the Windows 
Control Panel to make sure the 
SCSI board is listed.

■ If the SCSI board is found, but not 
the scanner, check the terminator 
switch and SCSI ID switch on the 
back of the scanner. Make sure the 
SCSI ID doesn’t conflict with 
another SCSI device. Unless the 
scanner is in the middle of a SCSI 
chain, the terminator switch 
should be set to ON.

■ If you’ve replaced your SCSI board 
or changed the SCSI ID, you may 
need to uninstall and reinstall your 
scanner software. See the 
instructions on page 60.

■ Check for IRQ conflicts with 
built-in options.

■ If you purchased the IEEE 1394 
scanner interface card as an option, 
make sure that it is installed 
correctly. (See page 44.)

■ If you are using the scanner on a 
network, make sure your EPSON 
Scan settings are configured for 
network operation.

■ If all else fails, uninstall and 
reinstall your software. See the 
instructions for uninstalling 
software on page 60.

■ If you are using the automatic 
document feeder, make sure the 
base of the feeder is flush against 
the back of the scanner.

The scanner doesn’t scan your 
image.

■ Make sure the scanner is ready to 
scan. Wait until the Ready light 
stops flashing and remains on. 

If you attempt to preview or 
scan before the scanner is ready, 
EPSON Scan may stop 
responding. If this happens, 
restart your computer.

■ Make sure the scanner’s 
transportation lock is in the 
Unlock position.

■ Check the Device Manager in the 
Windows Control Panel System 
utility. If there is an Unknown 
Device icon, select it and click 
Remove.
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■ If you’re using software like Adobe 
Photoshop Elements or PaperPort 
Deluxe, make sure you select 
EPSON GT-15000 as your 
scanner or import source. 

■ Make sure the SCSI ID switch on 
the back of the scanner is not set to 
the asterisk (*), and that it’s set to a 
number that doesn’t conflict with 
any other SCSI devices. If you 
reset the SCSI ID switch, turn the 
scanner off and then on again. 
Then restart your computer.

■ Make sure you have enough 
memory to scan your image. If 
you’re scanning a large image or 
scanning at a high resolution, 
close any unnecessary programs. 
Try scanning at a lower resolution, 
or select part of the image to scan. 
If you still cannot scan, you may 
need to upgrade your RAM.

■ If you have a SCSI ZIP drive, it 
may be interfering with your 
scanner. Disconnect your ZIP 
drive, restart your computer, then 
try scanning again. 

■ If you’re using the optional 
automatic document feeder, run 
EPSON Scan in Office Mode or 
Professional Mode, and select 
ADF-Single-sided or 
ADF-Double-sided as the 
Document Source. Also, make 
sure the original document is 
inserted face up.

When previewing a scan, you see a 
message that the document could 
not be located.

Make sure you’ve selected the correct 
Document Type in EPSON Scan. 

You can’t scan multiple images.

■ Position photos or documents at 
least an inch apart.

■ Make sure the application you are 
using supports multiple image 
scanning.

Pages jam in the automatic 
document feeder.

Remove the jammed pages, following 
the instructions on page 43.

The scanner doesn’t start when you 
press the a Start button.

■ Check the Events tab in the 
scanner’s properties window. 
Make sure Take no action or 
Disable device events are not 
selected.

■ If you’re using Windows NT, the 
Start button does not work in a 
non-network environment.
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Software Problems

EPSON Scan doesn’t work properly.

■ Make sure your system meets the 
minimum requirements. See the 
requirements on page 67.

■ Check your computer’s memory. 
If you’re running other software at 
the same time, have many device 
drivers, or you’re scanning a large 
image, the computer may not have 
enough memory. (See your 
software and computer manuals.) 

■ Check your software installation. 
Make sure that your software is 
correctly installed and set up. If all 
else fails, uninstall your software, 
then reinstall it.

You can’t select ADF as the 
Document Source (Office Mode or 
Professional Mode).

Make sure the optional automatic 
document feeder is installed correctly 
and securely connected to the ADF 
connector on the back of the scanner. 
If you need to reinstall or reconnect it, 
restart your computer afterward.

You can’t open PaperPort Deluxe.

Restart Windows, then try opening 
PaperPort again.

Quality Problems

Your scanned image is faint or out of 
focus.

■ Decrease the brightness setting in 
EPSON Scan Office or Home 
Mode.

■ Select Professional Mode and 
adjust the exposure using the  
Auto Adjust button. 

■ Select Professional Mode and 
adjust the Gamma setting using 
the  Histogram Adjust button. 

■ Check the condition of your 
original. If the document is 
damaged, dirty, or wrinkled, these 
imperfections will show up in your 
scan.

■ Make sure the document is placed 
flat against the document table.
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Your scanned image is blurred or 
distorted.

■ Check the position and condition 
of your document. Make sure the 
document is placed flat against the 
scanner’s document table glass. If 
only part of the image is blurred, 
part of your document may be 
wrinkled or warped. 

■ Make sure the document table 
glass is clean.

■ Make sure you didn’t accidentally 
move the document during 
scanning.

■ Make sure the scanner is on a flat, 
stable surface.

The edges of the document aren’t 
scanned.

■ Don’t place your document right 
up against the edges of the 
document table. Move the 
document about a quarter of an 
inch away from the edges.

■ If colors are patchy or distorted at 
the edges of the image, the 
document may be too thick, or 
there may be outside light 
interfering with the scan. If you are 
scanning without the cover, place 
paper over the edges of the 
document to block outside light.
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Your image scans at an angle.

Check the position of your document. 
It may be placed at an angle on the 
document table. Align it so the 
horizontal and vertical edges are 
carefully aligned with the scales on the 
top and side of the document table. 

Straight lines in the image come out 
jagged.

Make sure the document is aligned 
with the scales on the top and side of 
the document table. 

Your image is too dark.

■ Increase the brightness setting in 
EPSON Scan Office or Home 
Mode.

■ Select Professional Mode and 
adjust the exposure using the  
Auto Adjust button. 

■ Select Professional Mode and 
adjust the Gamma setting using 
the  Histogram Adjust button. 

■ Try different combinations of 
gamma and color settings in 
EPSON Scan. Click the 
Configuration button at the 
bottom of the window, then make 
any changes on the Color tab. 

■ Change the Destination setting in 
the Home or Office mode.

A line of dots is missing from the 
image.

■ When a line of dots is missing 
from the scanned image on your 
screen, the scanner sensor has 
malfunctioned. Contact your 
EPSON dealer.

■ When a line of dots is missing 
from your printouts, your printer 
has malfunctioned. See your 
printer manual.
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The colors in your scanned image 
look different from the colors in the 
original document.

■ Make sure the Image Type setting 
in EPSON Scan is correct.

■ Try different combinations of 
gamma and color settings in 
EPSON Scan. Click the 
Configuration button at the 
bottom of the window, then make 
any changes on the Color tab. 

■ Exact color matching is difficult. 
Check your software and monitor 
documentation for information on 
color matching and calibration.

Moiré (cross-hatch) patterns appear 
in the scanned image.

■ Make the image size slightly 
smaller.

■ In EPSON Scan, select the 
Descreening Filter checkbox. If 
you’re using Professional Mode, 
you may have to scroll to see this 
setting.

■ In Professional Mode, set the 
Screen Ruling to the appropriate 
setting for your document. 

■ Use a transparent sheet between 
the document and the document 
table to defocus the image slightly.

■ Reposition the document on 
the document table. Try 
positioning the document at a 
slight angle.

The image is larger or smaller than 
the original.

You can’t judge the size of the printed 
image by what you see on your screen. 
The image size settings in your scanner 
software determine the size of the 
printed image. Check the Target Size 
setting in EPSON Scan.

The image doesn’t scan, or you get 
only a few dots for the scanned 
image.

■ Make sure the document is face 
down on the document table.

■ If you’re using the automatic 
document feeder, make sure the 
original document is inserted 
face up.

■ Select Black&White for the Image 
Type and change the Threshold 
setting.

The file size is too big. 

Adjust your scan settings. Try setting 
at a lower resolution (dpi), or scan 
only part of the image.

Poor character recognition during 
OCR scanning.

Adjust the Threshold setting. 
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Uninstalling and Reinstalling EPSON Scan

If you’ve tried every other solution and your system still doesn’t recognize your 
scanner, try uninstalling and reinstalling the scanner software.

1. Turn off the scanner and disconnect it from the computer.

1. Double-click the Add or Remove Programs icon in the Windows Control 
Panel.

2. Select EPSON Scan, and click the Change/Remove (or Add/Remove) button.

3. Follow the on-screen instructions to remove the software. If you see a message 
prompting you to restart the computer, select Yes, I want to restart my 
computer now, and click Finish.

Follow the instructions beginning on page 13 to reinstall your software.
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Where To Get Help

If you are having problems with EPSON Scan or your scanner, see the contact 
information in the section below. If you are having problems with your other 
software, see page 62.

EPSON Technical Support

EPSON provides technical assistance 24 hours a day through the electronic support 
services and automated telephone services listed in the following table:

To speak to a technical support representative, dial (562) 276-4382 (U.S.) or 
(905) 709-3839 (Canada), 6 AM to 6 PM, Pacific Time, Monday through Friday. Toll 
or long distance charges may apply.

Before you call, please have the following information ready:

■ Product name (EPSON GT-15000)

■ Product serial number (located on the back of scanner)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration

■ Description of the problem

You can purchase supplies and accessories from the EPSON Store at (800) 873-7766, 
or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 
for dealer referral.

Service Access

World Wide Web From the Internet, you can reach EPSON Support at 
http://support.epson.com. At this site, you can download drivers and 
other files, look at product documentation, access troubleshooting 
information, and receive technical advice through e-mail.

Automated 
Telephone 
Services

A variety of automated help services are available 24 hours a day, 
seven days a week. To use these services, you must have a touch 
tone telephone and call (800) 922-8911. Your EPSON SoundAdvice  
Express Code is 70505. Use it to select your scanner in SoundAdvice.

SM
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Software Technical Support

Use the resources listed in the following table for help with the non-EPSON software 
that came with your scanner:

Software Telephone Fax Online and E-mail

Adobe 

Photoshop 
Elements

(206) 675-6358

6:00 AM to 5:00 PM, 
Pacific Time, Monday to 
Friday (pay support)

— www.adobe.com/support

techdocs@adobe.com

ABBYY 
FineReader 
Sprint 

(510) 226-6719 (510) 
226-6069

www.abbyyusa.com

support@abbyyusa.com

ScanSoft 
PaperPort 
Deluxe

(978) 977-8430

10:00 AM to 7:00 PM, 
Eastern Time, Monday to 
Friday (pay support)

— www.scansoft.com/
paperport/support
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Appendix A

Specifications

Scanner

General

Scanner type
Flatbed, color

Photoelectric device
Color MatrixCCD™ line sensor
Monochrome line sensor

Effective pixels
7020 × 10200 pixels (600 dpi)

Color depth 
48-bit internal/24-bit external

Grayscale depth
16-bit internal/8-bit external

Maximum document size
11.7 × 17.0 inches (297 × 432 mm)
(the reading area can be specified from 
your software)

Resolution
600 dpi (optical) 

Maximum hardware resolution*
600 dpi (main scan)
1200 dpi with Micro Step Drive™ 
(sub scan)
* The maximum hardware resolution of 

600 × 1200 dpi is achieved using EPSON’s 
Micro Step Drive technology

Maximum interpolated resolution
4800 dpi

Speed (600 dpi, draft mode)
Color: 3.8 msec/line (approx.)
Grayscale: 1.3 msec/line (approx.)
Line Art: 1.3 msec/line (approx.)

Color separation
RGB color filters on CCD

Reading sequence
Monochrome: One-pass scanning
Color byte sequence: One-pass scanning 
(R, G, B)
Color line sequence: One-pass scanning 
(R, G, B)

Zoom
50 to 200% in 1% increments

Command level
ESC/I-B7
FS

Pixel depth
16 bits per pixel input, 1 to 8 bits per 
pixel output

Brightness
7 levels

Line art settings
Fixed threshold
TET (Text Enhancement Technology, 
enable/disable selectable)
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Digital halftoning
AAS (Auto Area Segmentation,
enable/disable selectable)
3 error diffusion modes (A, B, and C)
4 dither patterns (A, B, C, and D) for
bi-level and quad-level data 
(2 downloadable dither patterns)

Gamma correction
2 types for CRT display
3 types for printer
1 type user-defined

Color correction
1 type for CRT display
3 types for printer (available in color
byte sequence mode and color line 
sequence mode)
1 type user-defined 

Interfaces
SCSI 2 (half pitch 50-pin connectors)
USB 2.0 (Type B receptacle connector)
IEEE 1394 (FireWire), optional
10Base-T/100Base-TX, optional

Light source
Xenon gas cold cathode fluorescent
lamp

Reliability
100,000 cycles of carriage movement
(main unit MCBF)

Dimensions
Width:  25.8 inches (656 mm)
Depth: 18.0 inches (458 mm)
Height: 6.2 inches (158 mm)

Weight
Approximately  29.8 lb (13.5 kg)

Electrical

Input voltage range
100 to 120 VAC: 90 to 132 VAC
220 to 240 VAC: 198 to 264 VAC

Rated frequency
50 to 60 Hz

Rated current
100 to 120 VAC: 0.8 A
220 to 240 VAC: 0.3 A

Power consumption
Operating: Approximately 50 W 

Approximately 75 W 
with ADF unit

Standby: Approximately 7.5 W

Environmental

Temperature
Operating: 41 to 95 °F (5 to 35 °C) 

50 to 89 °F 
Storage: –13 to 140 °F 

(–25 to 60 °C)

Humidity (without condensation)
Operating: 10 to 80%
Standby: 10 to 85% 

Operating conditions
Ordinary office or home conditions. 
Avoid dust, direct sunlight, and 
proximity to strong light sources.

Safety Approvals

120 V model
Safety: UL 1950 

CSA C22.2 No. 950
EN 60950

EMC: FCC part 15 
subpart B class B
CSA C108.8 class B
EN 55022 (CISPR Pub
22) Class B
AS/NZS 3548 class B

230 V model
Safety: EN 60950
EMC: EN 550022 class B, 

EN 55024, EN 61000-3-2, 3-3
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SCSI Interface

Interface type
ANSI X3T9.2/375R Revision 10L 
(SCSI 2)

Logic level
TTL-compatible

ID setting
Selectable from 0 to 7

Terminator
Internal terminator (enable/disable
selectable)

Connector type
Two half pitch 50-pin connectors

USB Interface

Interface type
Universal Serial Bus Specification
Revision 2.0

Electrical standard
Full speed mode (12Mb) and High 
speed mode of Universal
Serial Bus Specification Revision 2.0

Connector type
One receptacle (Type B)

IEEE 1394 FireWire

Interface type
IEEE 1394-1995 compatible

Data transfer method
Half-duplex Data/Strobe differential
serial

Synchronization method
Clock synchronization with DS-Link

Encoding/decoding
DS-Link

Logic level
3.3 V

Compatible connectors
IEEE 1394-1995 compatible

Power class
Power class code 100
No power supply from external sources
Fitted with a repeat function with bus 
power

Environmental

Temperature
Operating: 41 to 95 °F 

(5 to 35 °C)
Standby: –13 to 140 °F 

(–25 to 60 °C)

Humidity (without condensation)
Operating: 10 to 80%
Standby: 10 to 85%

ADF Connector

Interface type
For use with the optional automatic 
document feeder (B813212)

Output voltage
21.6 to 26.4 VDC
4.75 to 5.25 VDC

Output current
0.6 A (24 V)
0.3 A (5 V)
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Initialization Methods

SCSI interface
Hardware: Initialized when the scanner 

is turned on or the scanner 
receives a SCSI Reset signal 
from the SCSI interface

Software: Initialized when the 
software sends the Esc @ 
(initialize the scanner 
command), or the scanner 
receives a SCSI Bus Device 
message

USB interface
Hardware: Initialized when the scanner 

is turned on or the USB 
cable is plugged into the 
USB port on the scanner

Software: Initialized when the 
software sends the Esc @ 
command or the scanner 
receives a Bus Reset from 
the USB interface

Automatic Document 
Feeder (B813212)

General

Paper input/output
Load face up; eject face down

Paper quantity
100 pages (55 g/m2 paper, 
maximum total thickness 
under 0.48 inches [12 mm])

Reliability
100,000 sheets (load/eject MCBF)

Dimensions
Width: 23.8 inches (605 mm)
Depth: 19.2 inches (488 mm)
Height: 5.3 inches (134 mm)

Weight
Approximately 28.7 lb (13 kg)

Electrical

Input voltage
22.8 to 25.2 VDC
4.75 to 5.25 VDC

Input current
24 V: 1.5 A
5 V: 0.4 A
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Appendix B

Requirements and Notices

System Requirements

The minimum system requirements are listed below. For optimum performance, a faster processor and 
more memory are recommended. If you’re scanning high resolution images, you need more than the 
minimum available hard disk space.

Note: Color and tone reproduction are subject to the display capability of your computer 
system, including the video card, monitor, and software. See the documentation for these 
products for details.

■ A Microsoft Windows-compatible PC with a Pentium®-equivalent processor, 233 MHz or faster 
recommended 

■ Preinstalled Windows XP, 98, Me, or 2000 for USB connection; Windows XP, 98, Me, 2000 
Professional, or Windows NT Workstation with Service Pack 4 or later for SCSI connection

■ SCSI, USB, or FireWire IEEE 1394 (Windows XP, Me, or 2000 only) port; FireWire card must 
be OHCI-compliant

■ 128MB RAM (256MB RAM recommended for all systems) 

■ 300MB available hard disk space 

■ CD-ROM drive

■ SVGA color monitor with 800 × 600 resolution 

■ 16-bit, 65K-color display adapter card (24-bit display adapter card with millions of colors 
recommended)
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Important Safety Instructions

Read all of these instructions and save them for later reference. Follow all warnings and instructions 
marked on the scanner.

■ Unplug the scanner before cleaning. Clean with a damp cloth only. Don’t spill liquid on the 
scanner. Use a soft, dry cloth or a compressed air spray designed for cleaning electronic equipment 
to clean dust from the document table glass. 

■ Do not place the scanner on an unstable surface or near a radiator or heat source.

■ Use only the power cord that comes with this product. This product’s power cord is for use with 
this product only. Use of another cord (or use of this cord with other equipment) may result in fire 
or electric shock.

■ Use only the type of power source indicated on the scanner’s label. Always supply power directly 
from a standard domestic electric outlet with the AC power cord that meets relevant local safety 
standards.

■ Connect all equipment to properly grounded power outlets. Avoid using outlets on the same 
circuit as photocopiers or air control systems that regularly switch on and off.

■ Do not let the power cord become damaged or frayed.

■ If you use an extension cord, make sure the total ampere rating of the devices plugged into the 
extension cord doesn’t exceed the cord’s ampere rating. Also, make sure the total ampere rating of 
all devices plugged into the wall outlet doesn’t exceed the wall outlet’s ampere rating.

■ Do not attempt to service the scanner yourself. 

■ Unplug the scanner and refer servicing to qualified service personnel under the following 
conditions: if the power cord or plug is damaged; if liquid has entered the scanner; if the scanner 
has been dropped or the cabinet damaged; if the scanner does not operate normally or exhibits a 
distinct change in performance. Do not adjust controls that are not covered by the operating 
instructions. 
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Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or CPU 
Boards and Power Supplies used with Class B Personal Computers:

We: EPSON AMERICA, INC.

Located at: MS 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806-2469
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein complies with 47CFR Part 2 and 
15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative 
unit tested and found to be compliant with the standards. Records maintained continue to reflect the 
equipment being produced can be expected to be within the variation accepted, due to quantity 
production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to 
the following two conditions: (1) this device may not cause harmful interference, and (2) this device 
must accept any interference received, including interference that may cause undesired operation.

Trade Name: EPSON
Type of Product: Image Scanner
Model: J151A
Product: EPSON GT-15000
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FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio or television reception. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause interference to radio 
and television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures.

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.

■ Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

■ Consult the dealer or an experienced radio/TV technician for help.

Warning

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC 
Certification of this device and may cause interference levels which exceed the limits established by the 
FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment 
interface cable with this device. If this equipment has more than one interface connector, do not leave 
cables connected to unused interfaces. Changes or modifications not expressly approved by the 
manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le materiel brouilleur du 
Canada.
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ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined that this product meets the ENERGY STAR 
guidelines for energy efficiency.

The EPA ENERGY STAR Office Equipment Program is a voluntary 
partnership with the computer and office equipment industry to promote the 
introduction of energy-efficient personal computers, monitors, printers, fax 
machines, copiers, and scanners, in an effort to reduce air pollution caused by 
power generation.

Warranty

Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. (“EPSON”) warrants to the first end user customer of the 
EPSON product enclosed with this limited warranty statement that the product, if purchased and used 
in the United States or Canada, conforms to the manufacturer’s specifications and will be free from 
defects in workmanship and materials for a period of one year from the date of original purchase. 
EPSON warrants that the EPSON product is manufactured from new components and parts, or if you 
have purchased a refurbished product, like-new components and parts which perform like new and 
meet the EPSON standard of quality. For warranty service, you must provide proof of the date of 
original purchase.

What EPSON Will Do To Correct Problems: Should your EPSON product prove defective during the 
warranty period, please bring the product securely packaged in its original container or an equivalent to 
your EPSON Dealer or EPSON Customer Care Center. You are responsible for all costs (shipping, 
insurance, travel time) in getting the product to the service location. EPSON will, at its option, repair 
or replace on an exchange basis the defective unit, without charge for parts or labor. When warranty 
service involves the exchange of the product or of a part, the item replaced becomes EPSON property. 
The replacement unit may be new or refurbished to the Epson standard of quality, and at Epson’s 
option, the replacement may be another model of like kind and quality. Epson’s liability for 
replacement of the covered product will not exceed the original retail selling price of the covered 
product. Exchange or replacement products or parts assume the remaining warranty period of the 
product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and 
Canada. This warranty does not cover damage to the EPSON product caused by parts or supplies not 
manufactured, distributed or certified by EPSON. This warranty does not cover third party parts, 
components or peripheral devices added to the EPSON product after its shipment from EPSON, e.g., 
dealer-added boards, chips or drives. This warranty is not transferable and will not apply to products 
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purchased from an end user. EPSON is not responsible for warranty service should the EPSON label 
or logo or the rating label or serial number be removed or should the product fail to be properly 
maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, 
improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical 
current, software problems, interaction with non-EPSON products, or service other than by an 
EPSON Authorized Servicer. If a claimed defect cannot be identified or reproduced in service, you will 
be held responsible for costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. 
IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED 
TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY 
STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE 
VOID. IN THE EVENT THE REMEDIES ABOVE FAIL, EPSON’S ENTIRE LIABILITY SHALL 
BE LIMITED TO A REFUND OF THE PRICE PAID FOR THE EPSON PRODUCT 
COVERED BY THIS LIMITED WARRANTY. EXCEPT AS PROVIDED IN THIS WRITTEN 
WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL BE LIABLE 
FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR 
INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF 
WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts and some 
jurisdictions do not allow certain exclusions or limitations on damages, so the above limitations and 
exclusions may not apply to you. This warranty gives you specific legal rights, and you may also have 
other rights which vary from jurisdiction to jurisdiction. 

To locate the EPSON Authorized Reseller or EPSON Customer Care Center nearest you call: 
(800) 922-8911 or write to: Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012.
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A

ABBYY FineReader Sprint
installing, 13 to 14
support, 62
using, 23 to 24

Accessories, 37, 61
Adobe Photoshop Elements, 25, 62
Auto Adjust button, 32
Auto Detect button, 22, 26, 31, 34
Auto Exposure Type setting, 31
Automatic document feeder

Document Source setting, 42
double-sided scanning, 42
fixing document jams, 43
installing, 39 to 41
loading pages, 41
problems, 43, 52, 56
purchasing, 37, 61
specifications, 66
using, 41 to 42

B

Blurred image, 57
Brightness setting, 23, 27, 32, 56
Buttons, 52

C

Cleaning the scanner, 50
Color problems, 58 to 59
Connecting scanner, 15 to 16
Contrast setting, 23, 27, 32

D

Descreening Filter setting, 23, 33
Destination setting, 27
Document jams, fixing, 43
Document position, 20, 57
Document Type setting, 27
Documentation, 8 to 10
Double-sided scanning, 42

E

Electrical requirements, 64
Environmental requirements, 64
EPSON

help, 61
Store, 37, 61

EPSON Scan
Home Mode, 26 to 28
installing, 13 to 14
Office Mode, 22 to 24
previewing scans, 28, 34 to 35, 55
problems, 56
Professional Mode, 31 to 33
scanning to a file, 28
starting, 28

Error light, 52
Ethernet card, 46 to 47

F

Faint image, 56
FCC compliance statement, 70
File Save Settings, 28
File size, 59
FineReader Sprint, see ABBYY FineReader Sprint

Index
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FireWire
installing the scanner card, 44 to 45
scanner card specifications, 65
system requirements, 44

G

Gamma adjustment, 32, 59

H

Help
EPSON, 61
software, 62

Histogram adjustment, 32
Home Mode

description, 19
using, 26 to 28

I

IEEE 1394, see FireWire
Image Adjustment button, 32
Image quality problems, 56 to 59
Image Type setting, 22, 27
Installing

automatic document feeder, 39 to 41
FireWire scanner interface card, 44 to 45
Network Image Express interface card, 46 to 

47
software, 13 to 14, 17

L

Lights, 52
Loading documents

automatic document feeder, 41
single sheet, 20

Lock, transportation, 17, 49

M

Maintenance, 49 to 50
Moving scanner, 49

N

Network Image Express card, 46 to 47

O

OCR scanning, 23 to 24
Office Mode

description, 19
using, 22 to 24

Optional equipment, see Automatic document 
feeder, FireWire, Network Image Express

P

PaperPort Deluxe
installing, 13 to 14
support, 62
using, 21 to 23

Photoshop Elements, 25, 62
Preview window, 34
Problems

automatic document feeder, 43, 52, 56
color, 58 to 59
image quality, 56 to 59
previewing scan, 55
scanner, 53 to 55
software, 56

Professional Mode
description, 19
using, 31 to 33

R

Ready light, 52
Reference Guide, viewing, 9 to 10
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Requirements
electrical, 64
environmental, 64
system, 44, 67

Resizing images, 36
Resolution

choosing, 32, 35 to 36
maximum, 63

S

Safety instructions, 68
Scaling images, 36
Scanner

choosing location, 12
cleaning, 50
connecting, 15 to 16
installing software, 13 to 14
moving, 49
problems, 53 to 55
unpacking, 11

Scanning
color images, 36
documents with PaperPort Deluxe, 21 to 23
double-sided, 42
photos, 25 to 27
placing documents, 20
previewing scans, 28, 34 to 35, 55
Start button, 29 to 30
text for editing, 23 to 24
tips, 35 to 36
to a file, 28
with automatic document feeder, 42

Scanning Quality setting, 32
ScanSoft PaperPort Deluxe, see PaperPort 

Deluxe
SCSI

connecting to, 16
interface specifications, 65
problems, 54

Service, 61
Software

installing, 13 to 14, 17
problems, 56
uninstalling, 60

Specifications
automatic document feeder, 66
electrical, 64
environmental, 64
FireWire card, 65
scanner, 63 to 66

Start button, 29 to 30
Support, 61 to 62
System requirements, 44, 67

T

Target Size setting, 27, 32
Technical support, 61 to 62
Text scanning, 23 to 24
Tone correction, 32
Tone Correction button, 32
Transportation lock, 17, 49, 54
Transporting scanner, 49
Troubleshooting

automatic document feeder, 52, 56
image quality, 56 to 59
scanner, 53 to 55
software, 56

U

Uninstalling software, 60
Unpacking scanner, 11
Unsharp Mask Filter, 23, 33
USB

connecting to, 15
interface specifications, 65

User’s Guide, viewing, 9 to 10

W

Warranty, 71 to 72
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